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Integral Introduction
The ability to analyze and manage pharmacokinetic/pharmacodynamic (PK/PD) data from a 
variety of sources in a centralized, systematic, and organized manner is increasingly import-
ant as pharmaceutical scientists attempt to process and analyze data from early stage drug 
development and apply that information in the later stages of clinical testing. Added to this 
need are growing demands for regulatory compliance to Food and Drug Agency guidelines 
with respect to the way drug development data are collected and submitted for review.

Integral is a secure central repository for PK/PD and related data such as demographics and 
covariate information, as well as modeling and analysis files from other tools, with the 
resulting output data, images, and reports. Integral supports the use of Certara tools as part 
of an improved decision-making process within the pharmaceutical development organiza-
tion. The system can manage and provide effective access to data across a diverse set of 
compounds and development phases to support an improved, information-driven decision 
process during drug development.

Integral enables users to capture essential data from internal studies as well as publicly 
available information. With this information, users can build models of drug, disease, and 
subject interactions useful for clinical trial design. Integral enables members of the clinical 
development team, including biostatisticians, clinical pharmacologists, physicians, and trial 
designers, to communicate using the language of drug models and clinical trial simulation.

Select one of the following links to learn more:

User Interface Description

Working with Folders

Working with Files

Search Repositories

Filter the Browser List

Copy and Link

Blind and Unblind Folders and Files

Lock and Unlock Files

Controlling Notifications

Folder Types

Property Types

File Types

Audit Reasons

Database Security

Auditing Changes to Integral Data

System Audit Report
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Glossary

Integral Plugin, synchronize Phoenix projects with data stored in Integral 

Integral Client Application, synchronize local data with data stored in Integral. 

See the “Compatibility and Whitelisted URLs” section for browser compatibility information 
and a list URLs to be whitelisted.
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Compatibility and Whitelisted URLs
The Integral application is compatible with Firefox version 77 or greater, Chrome version 83 
or greater, Microsoft Edge version 83 or greater.

There are executables that may be flagged/quarantined by different antivirus software. This 
can cause Integral to function improperly or even fail. To avoid these types of problems, the 
following items should be included in an exception list for virus protection by your IT profes-
sional to enable all functionality, including Help and Support sites.

https://fonts.googleapis.com

https://integral.certara.com/

http://integral.certara.com/

https://integral-staging.certara.com/

http://integral-staging.certara.com/

https://auth.certara.com/

https://certara.com/

https://certara-ext-gw2ywp.okta.com/

https://api.segment.io

https://cdn.segment.com

https://ok11static.oktacdn.com

https://api.certara.io

https://onlinehelp.certara.com/

https://support.certara.com/

https://www.certara.com/

Note: On the login page, if you are unable to see the “Need help signing in” option, you may 
need to adjust your font size or display resolution.

After entering your log in credentials, if you are returned to the same login page, verify 
that your browser settings allow cookies to be saved and read. 
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User Interface Description
Log in

Toolbar

Repository

Browser

Favorites

Contents Tab

Properties Tab

History tab

Permissions tab
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Log in
Certara provides a set of rules that can be applied when an Integral user is creating their 
password. The default settings for these rules are shown in the following image. These set-
tings may be updated, if requested by your organization, by contacting Certara. 
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Toolbar

For more information, see:
– Search
– Database Security
– Compare files
– Copy and Link
– Folder Types 
– Property Types 
– File Types 
– System Audit Report



Integral
Guide

16

Repository
The name of the repository is shown on the right, under the toolbar. 

Click to select a different repository to which you have access. Once a repository is selected 
that is not the default, Set to default is displayed. 

Clicking Set to default changes the default repository to be the one currently selected.
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Browser

Select a folder in the Integral browser to expand the listing and see subfolders and files. The 
contents of the selected folder are also shown in the panel on the right, with some addi-
tional details, such as the date each item was last updated and the description. 

Near the top of the right panel, below the item’s title, is the path to the selected item. Click 

the  icon to copy the path to the clipboard. The copied path Is the full path with slashes, 
etc. 

Below is a list of some of the folder and file icons that can appear in the browser:

The Display Archived Folders checkbox controls whether locked (archived) folders are visi-
ble in the tree. See “Lock and Unlock Files” for more information on archiving files and fold-
ers. 
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Grouping
Grouping allows folders to be organized in the browser based on properties associated with 
those folders. 

1. Click  in the Integral browser toolbar.
2. From the list of Available Properties for root folders, drag any properties to use for 

grouping folders to the Selected Properties list.
3. Press Apply.

When grouping is applied, the Grouping icon above the browser changes to  and 
the same icon appears to the right of the grouped folders. Grouped folders will be listed 
first in the browser, followed by all folders where grouping is disabled. Notice the num-
ber in parentheses, indicating the number of root folders that fall into that particular 
category of the grouping.
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Control of whether a folder type can be included in grouping is located in the Admin 
module using the Grouping enabled setting. See “To add a folder type” for more infor-
mation.

4. The grouping settings are remembered until the properties selected are changed in this 
window. To save the Selected Properties list as the default grouping, check the Set 
Grouping As Default box. Then, when the Reset button is pressed, the list will reflect the 
saved default.

To return to the original default setting of grouping by root folder, drag all properties 
out of the Selected Properties list and check the Set Grouping As Default box. 

5. Use the Set Favorites as Default checkbox to control whether all folders are listed upon 
logging into Integral (unchecked) or if only the folders that have been marked as favor-
ites are listed (checked).
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Browser options menu

Selecting or hovering over an item in the Integral browser shows an ellipsis to the right. 
Click the ellipsis to display a pop-up menu of options. The options available in the menu 
depends on the type of the item and user’s permissions. Click the link for more information.

Add a top-level folder

Add a sub-folder

Edit properties of a folder

Edit properties of a file

Favorites

Upload file(s) to a folder

Download a file

Lock and Unlock Files

Blind and Unblind Folders and Files

Delete one or more folders

Delete a file
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Favorites
Add Favorites

1. Select an existing folder.
2. Click the ellipsis button.
3. Select Add to Favorites from the pop-up menu.

View Favorites

Toggle the Favorites icon above the Integral browser to switch between the full list of items 
and favorites list.
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Contents Tab
The contents of the item selected in the Integral browser are shown in the Contents tab 
along with the date each item was last updated and the description.

If the selected item is one of the following types, the contents of the file is displayed:
– Plain text files (TXT, LOG, etc.)
– CSV
– DAT
– HTML
– PDF
– Microsoft Word documents (DOC, DOCX, RTF)
– XPT
– Supported image file (BMP, GIF, JPEG, etc.)
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Properties Tab
The properties for a particular item are controlled by the system administrator (see “Prop-
erty Types”). Some of the more common ones are listed here:

Created On: Date folder/file originated.

Blinded: Indicates whether the folder/file is blinded (True) or unblinded (False).

Compound: Name of the drug(s) that used in the study.

Created By: Name of the person who created the file/folder.

Description: Optional narrative text that can be entered to describe the folder/file.

eSignature Required: Indicates whether the folder eSignatures are enabled (True) or dis-
abled (False)

Folder Type: Shows the value set for the Folder Type property.

Indication: The condition or illness that is being treated in the study (e.g., depression).

Locked: Indicates whether the folder/file is locked (True) or unlocked (False).

Name: Name of the folder/file.

Owner: The name of the user who owns the folder/file.

Portfolio: Different groupings of projects or compounds. For example, it could be used to 
group studies in a therapeutic area such as CNS.

Revision: Numeric identifier indicating the number of times the folder/file has been 
changed and saved up to that point.

Security Context: Shows if the folder is a Root Folder. 

Size: File size.

Study Design: Design of the study you selected. 

Study End Date: The ending date for the study.

Study Start Date: The beginning date for the study.

The Inherited Properties section lists any properties inherited from the parent folder.

View properties of a folder or file
1. Select the folder or file in the browser on the left.

Note: If needed, the list of studies can be filtered. (see “Filter the Browser List”).
2. Click on the Properties tab on the right:
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History tab
Every change that is made to a Integral file or folder is logged in an audit trail. A brief over-
view the history can be viewed or a full audit report can be generated. Users with a mini-
mum of READ access to the study can view the history and generate audit reports. 

View history of a folder or file

1. Select the folder or file in the browser on the left.

Note: If needed, the list of studies can be filtered. (see “Filter the Browser List”).
2. Click on the History tab on the right:
3. For a folder, expand the Events section, and click the arrow next to an ID to expand the 

row and view the files related to the event. 

If the event involved the deletion of a file, the file can be recovered by clicking  to 
download it. Then upload the file back to Integral as a new file. 

Use the Files in Selected Folder Tree dropdown to switch between only listing the files 
in the folder or listing all of the files that were part of the selected event.

4. For a file, a list of revisions is given. Click  to download a copy of the revised file. 

When there are multiple revisions for a file, click  to go back to that version of the 
file. The content of the file is reverted and it is logged as another revision. (If the file is 
within a savepoint and further work is needed on a particular version of the file, either 
revert the entire savepoint or download the needed file version.)



History tab

25

5. Expand the Properties section to view a list of associated properties, their values, the 
date of creation and the author. 

6. Expand the Save Points section (available only for savepoint-enabled folders) to see a 
list of previously saved savepoints, the date/time of creation of each savepoint (in UTC), 
and the author. 

See “Load a prior state of a folder” for more information.
7. To generate an audit report, click Generate Audit Report. See “Auditing Changes to Inte-

gral Data” for more information.

Note: The History tab for a study only displays the current data; it does not show the data prior 
to any changes.
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Permissions tab

1. Select the folder or file in the browser on the left.
2. Click on the Permissions tab on the right:
3. Click Effective User Permissions to expand the list of users and their permissions for the 

selected folder or file.

Type in the Search Users field to filter the list.
4. Click Effect Group Permissions to expand the list of groups and their permissions for the 

selected folder or file.

These permissions are determined by the permissions assigned to the author of the folder 
or file. See “Edit a user in the system database” for more on user permissions.

Note: If a folder’s author is editing the Effective User Permissions of a folder and an administra-
tor is making changes to the same folder in the Security module at the same time, what-
ever changes that are made last will be applied.
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Folders
Predefined Folder Types

View information about a folder

Add a top-level folder

Add a sub-folder

Edit properties of a folder

Transfer ownership of root folder

Delete one or more folders

Load a prior state of a folder

See also 

Folder Types

Copy and Link.

Blind and Unblind Folders and Files.

Lock and Unlock Files

Grouping
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Predefined Folder Types
The predefined folder structure in Integral is described in this section. It is important to 
remember that Integral is very flexible and that a very large percentage of the folder struc-
ture is customizable.

There are two predefined, top-level folder structures: 

Study - Set up for storing all information for a particular study, e.g., a clinical study. The 
study may be centered around a client, an indication, a study type, a study design, a 
compound, a therapeutic area, a group (team) of Integral users, a program, a phase, or a 
portfolio.

Library - As a top-level folder, this folder type could be used to store templates, reports, 
code files, graphics, or documents that might be used by multiple projects or studies. 

Folder properties are set when adding or editing a folder. (See “Add a top-level folder” and 
“Edit properties of a folder”.) They are used when setting up permission rules to identify the 
people who can access the folder and what they can do with the information in the folder. 
(See “Manage group rules”.)

Note: Two additional folder types have been designed to help PKS users move between PKS and 
Integral by keeping the same folder structure as PKS: Legacy Study and Legacy Library. If 
you have the legacy PKS plugin, you can continue to use it to update data and scenarios. 
Any changes made through the PKS plugin will be synced with the information in Integral. 
However, the reverse situation is not true. Change made through Integral will not be 
synced to PKS.

PKS scenarios can be opened in Phoenix through the Integral plugin by going to the corre-
sponding project and loading the desired scenario. Phoenix will open the scenario as a 
project. Note that a new version of the scenario cannot be saved, but it can be saved as a 
new project in Integral. (Right-click the scenario in the Object Browser and select Save to 
New Project in Integral.)
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View information about a folder

1. Select the folder in the list on the left.
2. Click one of the tabs on the right:

Content: Lists the sub-folders and files within the selected folder, the date the folder was 
last updated and any description that is associated with the folder.

Properties: Shows the file property values for the selected file. See “Properties Tab” for 
more details.

History: Shows details about changes made to the selected file. See “History tab” for 
more details.

Permissions: Lists permissions of the selected file. See “Edit a user in the system data-
base” for more information on permissions.
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Add a top-level folder

1. Select .
2. In the Add Folder pop-up, select a type from the Folder Type drop-down list.

The types listed are defined by the Administrator (see “Folder Types” for more informa-
tion).

3. Enter a name for the new folder.
4. Select whether the new root folder will require eSignatures to make updates (Enabled) 

or not require eSignatures (Disabled). 

If Integral is set up to only allow GxP folders, then Enabled will be the only option for 
new root folders.

5. Depending on the selected type, other options for entering information may appear in 
the pop-up.

Refer to “Predefined Property Types” for a list of predefined properties by folder type.
6. When finished, click Apply.
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Add a sub-folder

1. RECAP?Select an existing folder in the browser.

2. Click  and select New Folder from the pop-up menu.
3. In the Add Folder pop-up, select a type from the Folder Type drop-down list.

Folder types are defined by the System Administrator (see “Folder Types”).
4. Enter the name for the folder.
5. Gone?Select whether the new folder will require eSignatures to make updates 

(Enabled) or not require eSignatures (Disabled).
6. Depending on the selected type, other options for entering information may appear in 

the pop-up.

Refer to “Predefined Property Types” for a list of predefined properties by folder type.
7. When finished, click Apply.
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Edit properties of a folder

1. Select an existing folder in the browser.

2. Click  and select Edit from the pop-up menu.
3. In Properties tab, edit the name and/or other folder properties. 

Information that cannot be modified is grayed out.
4. When finished, click Apply.
5. Because you are making a change to the contents, an electronic signature is required.

Note: Some properties of system folders are not editable.

Only the owner can change the name of a root folder.
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Transfer ownership of root folder
Only a user with an Administrator license or the current owner can change the owner of a 
root folder. Once the change is completed, the previous owner will lose Security Admin per-
mission for that folder.

1. Select an existing root folder in the browser.

2. Click  and select Change Owner from the pop-up menu.
3. In dialog, select the name of the new owner from the list of available users. 

Only users with Security Admin permission are listed.
4. Click Change Owner.
5. Once the owner is changed, refresh the effective permissions by changing and resetting 

a permission (e.g., turn a permission on and then off again).
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Delete one or more folders
The action described here is a soft deletion of the folder. It does not permanently delete the 
folder from the database.

1. Select the folder to be deleted in the browser.

2. Click  and select Delete from the pop-up menu.

Or

In the panel, select  in the toolbar.

Or

In the Contents tab for the parent folder, click  to the right of the folder to be 
deleted.

3. In the Delete pop-up, click OK to confirm the folder deletion.

To delete multiple folders: 

1. In the Contents tab for the parent folder, check the boxes in front of the folders to be 
deleted.

Check the box in the column header to check all of the boxes.

2. Click  in the column header.
3. In the Delete pop-up, click OK to confirm the folder deletion.
4. Because you are making a change to the contents, an electronic signature is required. 
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Load a prior state of a folder
A “normal” folder is one where each item it contains is treated independently. That is, each 
item is versioned independently. A savepoint represents the state of a folder at a point in 
time, where the state is the collection of file revisions that are currently active in that folder 
and all children, recursively. Basically, a savepoint is a “snapshot of the analysis at a point in 
time.

The entire contents of a savepoint enabled folder is treated as a single entity. Any versioning 
occurs at the folder level. 

Saving a project from Phoenix to Integral automatically creates a savepoint to record the 
state of the project.

If two users are simultaneously working on the same version of a savepoint, the version that 
is saved later is branched off and saved as a new file. The history of the branched version will 
show the origin of the savepoint.

1. With the savepoint folder selected, go to the History tab.
2. Expand the Save Points section of the page. 
3. Expand one of the savepoints.

There are two categories of information stored with a savepoint: file and dependency infor-
mation. 

Files
Expanding Files shows the full path to each file saved in that savepoint and its revision num-
ber. 
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Click  next to a file to download the state of the file as it was when the savepoint was 
created.

Use the popup at the bottom of the browser window to specify what is to be done with the 
file.

Dependencies
Expanding Dependencies shows the full path to each identified by Phoenix as a dependency 
when the savepoint was created, its revision number, status (indicates if the file has been 
updated since the savepoint was created, and notification settings. 

Savepoint dependencies are saved to track dependencies on objects that exist in Integral. A 
very common dependency is when analysis output is dependent on the data collected as 
part of a study.

Integral is configured by default to store study data files in the “Data” folder. In Phoenix, 
when a new project is created from the Integral plugin, the user can select multiple source 
files to be included in the project. Phoenix retains the source of these objects in Object 
Browser.

When saving projects back to Integral from Phoenix, Phoenix will determine what depen-
dencies to save with the project by locating all objects in the project that have an External 
source that is an Integral object.

Levels of dependency that can be set when saving to Integral include: 

Invalidate and Notify: New version of referenced object is created or object is deleted, 
dependent projects are marked as out-of-date (invalidated), and notifications are cre-
ated. 

Invalidate: New version of referenced object is created or object is deleted, dependent 
projects are marked as out-of-date (invalidated). 

Notify: Do not invalidate projects but create notification for any user with access to proj-
ects. 

Neither: Dependency references particular revision of file and user is not concerned if 
new versions are created. Notifications are not created and the project is not marked as 
out-of-date. 
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Click  next to a file to download the state of the file as it was when the savepoint was 
created.

When a dependency is broken (e.g., the dependency file is updated or deleted), a notifica-
tion is sent to the user who created that dependency. Additionally, the savepoint folder and 
all parent folders up the tree will change to red (out-of-date). Once the broken dependency 
is resolved, the savepoint is updated and saved back to Integral, then the savepoint folder 
and parent folders change to blue. 
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Files
View information about a file

View and edit contents of a file

Edit properties of a file

Change status of a file

Delete a file

Upload file(s) to a folder

Upload a file revision

Download a file

Compare files

See also:

File Types

Copy and Link

Blind and Unblind Folders and Files

Lock and Unlock Files
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View information about a file

1. Select the file in the list on the left.
2. Click one of the tabs on the right:

Content: If the selected file is a csv, dat, or other format recognized by Integral, the con-
tent of the file is displayed and, depending on the file format, may be edited. See “View 
and edit contents of a file” for more details.

Properties: Shows the file property values for the selected file. See “Properties Tab” for 
more details.

History: Shows details about changes made to the selected file. See “History tab” for 
more details.

Permissions: Lists permissions of the selected file. See “Edit a user in the system data-
base” for more permission details.
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View and edit contents of a file
When a file is editable, a tooltip becomes available in the Contents tab explaining that the 
data can be modified by double clicking the cell.

Text files
1. Select the text file.
2. Go to the Contents tab.
3. Edit the displayed text.
4. Click Apply. 

Because you are making a change to the contents, an electronic signature is required.

The modified file is saved as a new revision, as can be seen in the History tab after refresh-
ing the display.

.csv or .dat files
1. Select the file.
2. Go to the Contents tab.
3. Use the navigation tools below the table to page through the data, go to a particular 

page, or to set the number of items to display per page.

Sorting the columns can be accomplished by simply clicking on the column header. Clicking 
the header multiple times will toggle between ascending, descending, and unsorted. A sort 
direction indicator is shown in the header. When a column is sorted, the column header 
label is black.

Alternatively, click  in the column header and select Sort A to Z or Sort Z to A in the 
popup.

Filtering a worksheet is done through the icon in the column header.

1. In the header of the column to be filtered, click .

The popup lists all values found in that column.
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2. To search for values, begin typing the text in the Search field and the list in the popup 
will automatically be filtered as you type.

3. Use the check boxes in the list to control which rows are shown (checked boxes) or hid-
den (unchecked boxes) in the result worksheet. Use the (Select All) check box to check 
or uncheck all items in the list at the same time.

4. To define a filter criteria, click “>” next to Text Filters and select the operator.

When using text filters, all data in the grid are handled as text, even numeric values.
5. In the dialog, use the dropdown menu to change the operator and enter the value(s) to 

set the criteria. 

6. To include a second criteria, select the AND or OR radio button and use the second 
dropdown menu and field to define the second criteria.

7. Check the Match Case box to make the criteria case sensitive.

Editing cell content is done directly in the displayed table.
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8. To edit cell contents, double-click a cell.

A red underline displays to indicate the cell being edited.
9. After editing, press the Enter key or click outside of the edited cell.

The edited cell’s background changes to light green to indicate an unsaved change.

10. Press the Update button above the table and press OK to confirm.

Because you are making a change to the contents, an electronic signature is required.

The modified file is saved as a new revision, as can be seen in the History tab after refresh-
ing the display.

Note: For locked files, even though it is possible to edit values displayed in the Contents tab, 
click Update and submit an electronic signature, the contents of the file stored in Integral 
will not be updated.
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Edit properties of a file

1. Select a file.

2. Click  and select Edit from the pop-up menu.

Or

In the panel, select  in the toolbar.
3. In Properties tab, edit the Name, Description, and/or Status of the file. Depending on 

the type of file, Has Header Row and Has Units Row settings may be available. For 
CDISC files, you can change the CDISC Model.

4. When finished, click Apply.
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Change status of a file
The status of a savepoint-enabled folder or any file located outside of a savepoint-enabled 
folder can be changed.

1. Select an existing savepoint-enabled folder or a file that is outside of a savepoint-
enabled folder in the browser.

2. Click  and select Change Status from the pop-up menu.
3. In dialog, select the desired status. 
4. Click Apply.

The list of available status values can be edited by an Administrator, see “To modify a prop-
erty” for details.
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Delete a file
The action described here is a soft deletion of the file. It does not permanently delete the 
file from the database.

1. Select the file to be deleted.

Click  and select Delete from the pop-up menu.

Or

In the panel, select  in the toolbar.

Or

In the Contents tab for the folder, click  to the right of the file to be deleted.
2. In the Delete pop-up, click OK to confirm the file deletion.

To delete multiple files:

1. In the Contents tab for the folder, check the boxes in front of the files to be deleted.

Check the box in the column header to check all of the boxes.

2. Click  in the column header.
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3. In the Delete pop-up, click OK to confirm the deletion.

Because you are making a change to the contents, an electronic signature is required.

The deleted file can be recovered through the “History tab”. 
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Upload file(s) to a folder
Up to 5 GB can be uploaded to Integral at one time. Note that the filename cannot exceed 
255 characters and the full path (including the filename) cannot exceed 4096 characters).

Drag file(s) from the Explorer window to the Contents tab of the folder.

Or

1. With the desired folder selected, click  in the right panel toolbar.

This icon is displayed only if you have permission to upload files to the folder.
2. In the Explorer window, select the file(s) to be uploaded.

Or

1. Select the folder in which to add the file(s).

2. Click  and select Upload file(s from the pop-up menu.
3. In the Upload File(s) dialog drag and drop the files into the central area or click the cen-

tral area to display the Open dialog to browse and select the files.

Because you are making a change to the contents, an electronic signature is required.
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Upload a file revision

1. Select a file.

2. Click  and select Upload a New Revision from the pop-up menu.
3. In the dialog, drag the files from an Explorer window to the central area or click in the 

central area to display the Open dialog to browse and select the files.

The file being uploaded does not have to have the same filename as the file you are upload-
ing to. When the names are different, a confirmation is required and then the contents of 
the old file are replaced with the contents in the new file, but the file name remains 
unchanged.

Because you are making a change to the contents, an electronic signature is required.
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Download a file
Up to 5 GB can be downloaded from Integral at one time.

1. Select the file to download.

2. Click  and select Download file(s) from the pop-up menu.

To download multiple files in a folder:

1. With the folder containing the files selected, check the boxes of the files to download in 
the panel on the right.

2. Click  in the panel toolbar.

This icon is displayed only if you have permission to download items in the folder.

Note: It can take time to create the zip file, when the file is ready, you will see a pop-up at the 
bottom of the web browser window.

3. In the browser pop-up, specify what to do with the zip file of data.
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Compare files
Note: Comparison of files is restricted to text files only.

1. Click  in the main toolbar.
2. In the browser on the left, click to select one of the files to compare.

The contents of the file appear in both fields on the right.
3. Drag and drop the second file to compare from the browser to the comparison area.

The second file’s contents are loaded into the right comparison field. 
4. To change the file being compared, drag and drop another file. 

The contents of the right comparison field are updated. Anytime another file is dropped 
in the comparison area, it is only the right field that is updated.

5. To change the contents appear in the left field, repeat step 2.

Once again, the content of the selected file is loaded into both comparison fields. Con-
tinue by dragging the file to compare as in step 3.

Depending on the size of the files, it may take some time to display the comparison. Scroll-
ing is synchronized vertically between the files. Differences between the files are high-
lighted in red and green. A small area on the far right, next to the second file’s scrollbar 
provides a visual indicator of where the differences are located within the files so you can 
scroll directly to those lines.
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Search
When using the Search functionality, the results are always files, not folders. A search will 
return files that:

– Have a property matching the search criteria
– Have content that contains the search criteria (text files or text datasets)
– Have inherited properties matching the criteria (all files inherit properties from the 

parent (and their parents, back to the root)).

(In contrast, when using the Filter functionality, you are filtering root folders.)

Integral offers two search methods: 
– Basic Search
– Grid Search
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Basic Search

1. On the Integral main window, click  in the main toolbar.
2. In the Search page, with the Basic tab selected, type the query to search for and press 

the Enter key. 

OR versus AND Searches 

By default, an OR search is performed using the words entered in the query. For exam-
ple, entering: 
residual error 
finds files where the word residual or the word error is found in the contents.

​Entering:
residual AND error
finds files where both residual and error are found, but not necessarily next to 
each other. AND must be all capital letters or it will be included as a word in the query.

Exact Match Searches 

Use double-quotes when an exact match is to be performed. Entering:
"residual error"
(double quotes included) finds files where the phrase residual error occurs. 

Case Sensitivity 

The search functionality is case insensitive.

Wildcards 

The asterisk wildcard (*) represents multiple characters in a query. A question mark (?) 
represents a single character. For example, entering:
resid*
finds files that contain words starting with resid, like residual.
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Entering:
m?crosystem
finds files that contain words with any character in the 2nd position, like macrosystem 
and microsystem.

The information button  on the right side of the window provides a quick reference 
syntax list.

Additional filter options to Include deleted documents and to Include all versions can 
be specified by checking the corresponding box(es).

3. When the results are returned, you can optionally use the Refine Results list at the bot-
tom left to select categories that were found to contain one or more matching items.

4. Select an item in the results list to display the contents in the panel on the right. 

Notice that, on the far right side, there is a thumbnail of the overall file contents to help 
you track where the lines you are currently viewing are located in the file.

5. To locate a file in the repository, select the ellipsis next to the file and choose Home to 
be redirected to the exact location of that file within the Home screen. 
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Grid Search
The Grid Search allows you to search for files or folders meeting certain metadata criteria 
using a grid system with filters.

1. On the Integral main window, click  in the main toolbar.
2. Select the Grid tab. 

3. Load metadata on which to filter.

A subset of column data is visible by default. However, additional columns of metadata 
can be added by checking one or more boxes above the grid. When checked, any meta-
data associated with that category is added to the grid. 

4. Select  in the column header to define criteria on which to filter the column. 

See “View and edit contents of a file” for details on sorting and filtering.

5. Once you locate the desired file or folder, you can download the contents by clicking  
at the beginning of the row. 

6. When you have the desired list of files/folders, press the Export Excel button above the 
grid to download the information as an Excel spreadsheet file.

Below the grid are the tools for navigating the pages of data and the control for the number 
of items listed per page.
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Filter the Browser List
Many functions in the Integral Web client require selection from a list in the Integral 
browser. To locate specific items, the user may filter the list using the filter icon at the top of 
these windows. 

1. Above the Integral browser, select the filter icon .
2. In the Filter pop-up, specify a name for the filter.
3. Enter the name or partial name of a user to view root folders owned by that person.

As you type, a list of matches is provided from which to select the desired name.
4. Select a type of root folder using the Folder Type drop-down list.
5. Filter folders by property values that are specific to the selected folder type. 

Note: Pop-up menus only allow selection of a single item from the menu. If there are check 
boxes in the pop-up, you may check multiple items. Typed fields are not case-sensitive and 
accept the wildcard “*”.
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6. Filter folders based on their descriptions by entering keywords/phrases in the Descrip-
tion field.

An exact match is applied to the text entered in this field. Only folders that have the 
exact text, and only that text, as a description are returned. Therefore, it is important to 
add an asterisk as a wildcard before and/or after the text to return items that contain 
the entered text as part of their description.

7. List folders that have been modified by a particular person using the Modified by menu.
8. List folders that have been changed during a time period by entering dates in the From 

and To fields (click on the calendar icon to use a calendar pop-up).
9. Use the Locked menu to list only folders that are locked (True) or unlocked (False).
10. Use the eSignature Required menu to list only folders that require an eSignature (True) 

or do not require an eSignature (False).
11. When finished, click Apply.

Whenever a filter is in effect in the browser, the icon appears as .

Use the Clear button to remove all selection or entries from the Filter pop-up.



Integral
Guide

58

Copy and Link

1. Click  in the main toolbar, select the folder/file to copy in the list on the left and 
dragging it to the folder where the copy is to be saved in the right panel.

2. In the Copy/Link pop-up, select Link from the menu to create a link between the original 
and the copied file or select Copy to create a separate copy of the item. 

3. For folders, check the Include all subfolders box to link/copy all subfolders and their 
content as well.

4. When linking items, check the Auto Update box to automatically update the destination 
file(s) if the linked source file(s) are updated.

5. When copying items, check the Notify box to be notified when the source file changes.

(Notifications are automatically sent for linked items when the source file changes.)
6. Because you are making a change to the contents, an electronic signature is required for 

copying and linking. 

When linked, the icon for the linked file changes to  and the menu options available 

when clicking  include Get Latest, to update the linked item with any changes that 
have been made to the source, and Unlink, to remove the connection.
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Note: When a file is copied or linked to a folder, the copy or linked version will inherit the per-
missions of the folder to which it has been copied or linked. It does not retain the permis-
sions of its source folder.

To unlink a file

1. In the Copy/Link panel, click  for the file to unlink.
2. Select Unlink in the pop-up menu.
3. In the Unlink pop-up, click OK to remove the file from the location.

Or

Check the Keep as a copy box and click OK to remove the link, but keep the copied file in 
the location.

Unlinking requires an electronic signature. 
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Blind and Unblind Folders and Files
Note: If you do not see the icon or menu options for blinding, you may not have the necessary 

permissions. Check with your Administrator. 

To blind a single file
1. Select the file to blind in the browser.

Locked files cannot be blinded.

2. Click  and select Blind File from the pop-up menu.

Or

Click  in the panel toolbar.
3. An electronic signature is required for this action. 

Once the file is blinded, the Content tab is no longer available for viewing and the Blinded 
property in the Properties tab is set to True. In the browser, a blinded folder or file will have 

. 

To blind all files in a folder
1. Select the folder in the browser.

2. Click  and select Blind All Files from the pop-up menu.
3. An electronic signature is required for this action.

To unblind files
1. Use the same instructions for blinding, but select Unblind File or Unblind All Files from 

the pop-up menu.

Or

Click  in the panel toolbar.
2. An electronic signature is required for this action.

Once the folder/file is unblinded, the Content tab becomes available for viewing and the 
Blinded property in the Properties tab is set to False.

Multiple folders/files can be unblinded using the same process as described above for 
blinding multiple folders/files.
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Lock and Unlock Files
Note: Only a user assigned the license of Archivist will have access to the unlock functionality.

Files or folders within a savepoint folder cannot be locked.

To lock files

1. Select the file or the folder containing the files to lock in the browser.

2. Click  in the panel toolbar.

Or

Click  and select Lock File (Lock All Files, if a folder is selected) from the pop-up 
menu.

3. An electronic signature is required for this action.

Once the file is locked, no changes can be made to the contents of the file and the Locked 
property in the Properties tab is set to True. In the browser, a locked folder or file will have 

 next to the name. Use the Display Archived Folders checkbox to control whether locked 
folders are visible in the tree. 

When content within a folder is blinded, locking is only permitted at the Root Folder level.

To unlock a file

Note: Only a user assigned the license of Archivist will have access to the unlock functionality.

1. Select the file to unlock in the browser 

2. Click  in the panel toolbar.

Or
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Click  and select Unlock File (Unlock All Files, if a folder is selected) from the pop-
up menu.

3. An electronic signature is required for this action.

Once the file is unlocked, the contents of the file can be modified and the Locked property 
in the Properties tab is set to False.
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Notifications
Integral has several types of notifications that can be sent to users: System Notices, Applica-
tion Events, Application Errors, File Change Notice, and Application Warnings.

The Notifications icon in the banner will show the number of notifications received. 

1. Click the icon to display the Notifications panel.

The Notifications tab lists the notifications received. Each notification has a colored bar 
indicating the severity. red is critical, orange is important, yellow is normal, and green is 
low. The Options tab allows you to control subscription to different types of notifica-
tions.

To view the details of the notice, click the title of the notification
2. Click the Refresh icon in the Notifications tab to reload the list of received notifications 

and include any new ones.
3. Click the Delete icon at the top of the list of notifications to delete all received notifica-

tions.
4. Click the Delete icon next to an individual notification to delete that specific one.
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Subscribe/unsubscribe

Click the slider of the subscription to change between Subscribed and Unsubscribed.
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Folder Types
Integral has a number of predefined folder types. See “Predefined Folder Types”for informa-
tion about these types.

To add a folder type

1. Click  in the main toolbar.

2. In the Structure tab, click .
3. In the Add Folder Type popup, enter a name for the new folder type.
4. Indicate if this folder type is a root folder (select Yes) or not (select No).

Selecting Yes sets the Security Context to Root Folder and disables the selection of any 
Parent folder type. Selecting No removes Root Folder from the Security Context menu.

5. Check the boxes for all parent folder types (list on the left) in which the new type can be 
added.

Check the boxes for all child folder types (list on the right) that can be added to a folder 
of this new type as child folders.

6. Toggle the File Upload menu to control if files can be uploaded into this folder type 
(True) or not (False). 

7. Toggle the Auto-Creation menu to control if a folder of this new type is automatically 
created when a folder of the new type is added (True) or not (False). 
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8. Toggle the Savepoint Enabled menu to control if this folder and all its contents are to be 
saved as a savepoint when changes are made and uploaded (True) or not (False). 

9. Toggle the Savepoint Container menu to control if savepoints can be created within this 
folder.

When this option is set to True, the File Upload and Savepoint Enabled options will 
automatically be set to False.

10. Select a Security Context for the new folder type from the menu. Choose from Root 
Folder, Data, Analysis, or Documents.

These categories are used when setting up permissions. (Refer to “Edit a user in the sys-
tem database” and “Manage group rules” for more details on setting permissions.)

Unlike the other contexts, if Root Folder is selected when the folder type is created, it 
cannot be changed to a different context later.

11. Toggle the Grouping Enabled menu to control if this folder type can be grouped by prop-
erties (True) or not (False).

12. Click Apply.

The new folder type is added to the table and has an entry in the Configuration column of 
Custom.

To modify a folder type

 

1. Click  in the main toolbar.
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2. In the Structure tab, click  next to the folder type to edit.
3. In the Edit Properties expanded section, modify the name by typing in the Folder Type 

field.
4. Check the boxes for all parent folder types in which the new type can be added.
5. Toggle the File Upload menu to control if the files can be uploaded into this folder type 

(True) or not (False). 
6. Toggle the Auto-Creation menu to control if this folder type is automatically created 

when a parent-type folder (which was set when this folder type was created) is added 
(True) or not (False). 

7. Toggle the Savepoint Enabled menu to control if this folder type is included in a save-
point (True) or not (False). 

8. Toggle the Savepoint Container menu to control if savepoints can be created within this 
folder type (True) or not (False). 

9. Select a different Security Context for the folder type from the menu. 

The folder permissions will update to match the ones associated with the selected con-
text. 

If Root Folder was selected when the folder type was created, this option cannot be 
changed.

10. Toggle the Grouping Enabled menu to control if this folder type can be grouped by prop-
erties (True) or not (False).

11. Click Apply.

To delete a folder type

To delete a folder type, click  next to the folder type and then confirm the deletion in the 
popup.

Note: If a folder type is in use, you will not be able to delete it and selecting  will generate a 

warning message. If the icon is inactive ( ), the corresponding folder type a built-in Sys-
tem configuration type and cannot be deleted.
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Property Types
Refer to “Predefined Property Types” for a list of predefined properties by folder type.

To add a property

1. Click  in the main toolbar and select the Properties tab.

2. Click  below the list of properties.
3. In the Add New Properties popup, enter the name by typing in the Property Name field.
4. In the Applies to Folders popup menu, check all of the folder types where this property 

is to be applied.
5. In the Applies to Files popup, check all of the file types where this property is to be 

applied.
6. Check the Required box to mark this property as required when adding folders of the 

type(s) specified in the Applies Folders popup. 

If unchecked, the specified folders are able to be created without this property being 
defined.

7. In the Property Type popup, select interface mechanism to use for specifying the prop-
erty value(s). Depending on the type selected, the Values field is displayed for entering 
all of the values from which users can choose for this property.

8. Click Apply.
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To modify a property

Note: If a property has  at the end of the row, it is locked and requires a password to edit or 
delete. See “Lock and Unlock Files”.

Any modifications made to properties only affects new folders or files generated after the 
change. Existing folders or files are unaffected.

1. Click  in the main toolbar and select the Properties tab.

2. Click  next to the property to edit.
3. In the Edit Properties expanded section, modify the name by typing in the Property 

Name field.
4. In the Applies to Folders popup menu, check all of the folder types where this property 

is to be applied.
5. Toggle the Required check box to switch whether this property is required when adding 

folders of the type(s) specified in the Applied Folders popup or not required. 
6. For Radio, Dropdown, Combobox, and Multiselect property types, modify the list of Val-

ues from which users can choose for this property. The list is editable, just click and type.
7. In the Applies to Files popup, check all of the file types where this property is to be 

applied.
8. Click Apply.
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Predefined Property Types
The predefined property types in Integral are listed below. It is important to remember that 
Integral is very flexible and that property types (with the exception of System Properties) are 
highly customizable.

Analysis Type   CDISC Model   Compound

Has Header Row   Has Units Row   Legacy Properties

Phase   Status   Study Design   Study Type

Therapeutic Area   Tool Version
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File Types
To add a file type

1. Click  in the main toolbar and select the File Type tab.

2. Click .
3. In the Add File Type popup, enter the extension of the new file type. 
4. In the Icon Type popup menu, select the icon to associate with the file type. 

Data file = , Image = , Text = , unknown file type = .
5. In the Binary popup, select True to indicate the file is to be considered as binary or False 

if it is not binary.
6. Click Apply.

To modify a file type

Note: If a file type has  at the end of the row, it is prepopulated and cannot be edited.
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1. Click  in the main toolbar and select the File Type tab.

2. Click  next to the file type to edit.
3. In the expanded section, modify the extension by typing in the Extension field.
4. In the Icon Type popup menu, select the icon to associate with the file type. 
5. In the Binary popup, select True to indicate the file is to be considered as binary or False 

if it is not binary.
6. Click Apply.
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To delete a file type

1. Click  in the main toolbar and select the File Types tab.

2. Click  next to the file type and then confirm the deletion in the popup.
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Audit Reasons
Administrators can add or remove audit reason. 

To add a reason

1. Click  in the main toolbar and select the Audit Reasons tab.

2. Click .
3. In the Add Audit Reason popup, enter the text for the new reason.
4. Click Apply.

The new reason is added to the table and will appear in the Reason menu when an eSigna-
ture is required. For eSignature disabled folders, a system-generated reason will be recorded 
in the audit trail.
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To modify a reason

 

1. Click  in the main toolbar and select the Audit Reasons tab.

2. Click  next to the reason to edit.
3. In the expanded section, modify the text by typing in the Reason field.
4. Click Apply.

To delete a reason

1. Click  in the main toolbar and select the Audit Reasons tab.

Click  next to the reason and then confirm the deletion in the popup.
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Database Security

1. On the Integral main window, click  in the main toolbar.

Note: The Security icon is only visible if you have the “Administrator” role.
2. Choose one of the tabs:

– Users (individual user) 
– Groups (group of users labeled as a group name)

The security tools can be used to accomplish the following tasks:

Add a user to the system

Search for a user within the system

Edit a user in the system database

Add a group to the system database

Search for a group within the system database

Edit a group in the system database

    Manage group rules

    Manage members within a group

Delete a group in the system database

Example of permission setup for an external partner

See “Predefined License Types Table” for descriptions of the predefined license types for 
Integral users.
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Add a user to the system

1. Click  in the toolbar to display the Users tab.

2. Click  above the list of existing users.
3. In the Add User popup, type the email, first name, and last name of the user to add.
4. Check the Use SSO Credentials... box to automatically use the SSO credentials when 

eSignatures are required.

If unchecked, the user will need to enter their Integral username and password when an 
eSignature is required.

5. Check the Send Activation Email box to forward an email notification to the user being 
added.

6. Either click Add to add user to the Integral system or Cancel to close the popup without 
adding the user.

See “Edit a user in the system database” to assign license types to users.
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Search for a user within the system

1. Click  in the toolbar and select the Users tab.
2. Check the Display inactive users box to view users whose OKTA status is inactive as well 

as active.
3. Click near the Search Users heading and begin typing the name.
4. Click on a name in the filtered list to view the user’s properties on the right panel.

Notice the up arrow next to the Username column header in the previous image. This indi-
cates that the list is currently sorted in ascending order. Click the Username column header 
multiple times to switch between ascending, descending, and no sorting.
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Edit a user in the system database

1. Click  in the toolbar to display the Users tab.
2. Select a user to edit from the list.
3. Toggle between three tabs in the right panel.

Licenses, Group Membership, and Folder Permission govern user access to content.
– Licenses: The “maximum” permissions a user can have for any root folder. It is 

largely tied to license type.
– Group Membership: Provides access to “folder types” according to defined proper-

ties. 
– Folder Permissions: Provides additional permissions to folders beyond those set by 

group membership, assuming that the assigned Role allows for that permission. 

Note: A user that is assigned a license must also be assigned as a group member or granted 
permissions in the Folder Permissions tab, or both to access any data in Integral: 

Permissions are additive. Thus, if a user belongs to two groups, his/her permissions are a 
sum of the permissions for the two groups. Similarly, if a user belongs to a group, he/she 
can be granted permissions, via the Folder Permissions tab, to additional folders that are 
outside of the group’s access.

If a folder’s author is editing the Effective User Permissions of a folder and an administra-
tor is making changes to the same folder in the Security module at the same time, what-
ever changes that are made last will be applied.
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If all Licenses and Permissions are removed from a user, that user will no longer be able to 
log into Integral. 

4. In the Licenses tab, check on/off the box(es) to assign a license to the selected user:

Click the information icon ( ) to see additional details about each license.

Predefined License Types Table 
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Note: The Archivist license is free of charge when other licenses are purchased and multiple 
Archivist licenses may be requested.

5. In the Group Membership tab, check on/off the box(es) to specify the groups of which 
the selected user is to be a member. 

An administrator can grant other users (Full-Licensed User, QA, Archivist, Partner etc.) 
permissions in the Group Membership tab as long as there are no permission conflicts. 

A permission conflict is indicated by a  in the Status column. It means despite group 
membership, this user will not have all the permissions that the Group is trying to give 
him/her. Therefore, when an administrator is assigning licenses, make sure to also 
check the permissions in Group Membership tab. 

6. In the Folder Permissions tab, check on/off the box(es) to define the folder permissions 
to grant the selected user. The permissions are grouped into 5 categories. Checking a 
box in the Check All category checks all boxes with the corresponding label in all of the 
other categories (e.g., if Read is checked under Check All, then Read will be checked for 
Root Folder, Data, Document, and Analysis). The remaining 4 categories represent the 
security contexts that were assigned when the folder type was created: Root Folder, 
Data, Document, and Analysis. 

Name and Has Permissions columns can be sorted by clicking the column header.

For each security context, the following permissions can be set:

Read 
– Access to folder and its files and subfolders
– Download file from the folder
– Generate search results that include files from the folder
– Load a Phoenix project into Phoenix
– Load a selected item into Phoenix
– Sync a folder from Integral to the local directory

Create (when combined with Read permission)
– Upload files to folder
– Add subfolders to folder
– Copy/Link files to folder
– Add a savepoint
– Add selected items to folder
– Sync folder or new files to folder from the local directory to Integral

Edit (when combined with Read permission)
– Edit name and properties of folder or of file within folder
– Edit content (data) of files in folder
– Upload new versions of files within folder
– Perform a Save or Save As for a savepoint
– Save options when saving a savepoint
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– Sync updated files to folder from local directory to Integral

Delete (when combined with Read permission)
– Delete folder, which also deletes all content in folder
– Delete individual files and subfolders within folder (unless it is a savepoint)

Lock (when combined with Read permission)
– Lock the folder, which also locks all content in the folder
– Lock individual files and subfolders within folder (unless it is a savepoint)

View (when combined with Read permission)
– View contents of blinded folder or of files and subfolders within blinded folder
– Use a blinded file as a dependency for a savepoint
– Sync a blinded folder or blinded file or blinded subfolder from Integral to local direc-

tory
– Sync a new file or subfolder or updated file to a blinded folder from local directory to 

Integral 

Set/Unset blind (when combined with Read permission)
– Blind/Unblind folder, which also blinds/unblinds all content in folder, respectively.
– Blind/Unblind files or subfolders within folder
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Add a group to the system database

1. Click  in the toolbar and select the Groups tab.

2. Click  above the group list.
3. In the Add Group popup, type the new group’s name.
4. Either click Add to add the group to the list or Cancel to close the popup.

The group is add to the list on the left and selected so that rules and members can be imme-
diately defined. See “Edit a group in the system database” for more information.

New groups can also be created by copying an existing group and then editing it as needed.

 

1. Select the group to copy in the list on the left. 

2. Click . 
3. In the Copy Group popup, type the new group’s name.
4. Either click Copy to create a copy of the group or Cancel to close the popup.
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Search for a group within the system database

1. Click  in the toolbar and select the Groups tab.
2. Click the Search Groups heading and begin typing the name.
3. Click on a group name in the filtered list to view the group’s properties on the right 

panel.

Notice the up arrow next to the Group column header in the previous image. This indicates 
that the list is currently sorted in ascending order. Click the Group column header multiple 
times to switch between ascending, descending, and no sorting.
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Edit a group in the system database

1. Click  in the toolbar and select the Groups tab.
2. Select a group to edit from the list.

3. To edit the group name, click . type the name, and click the checkmark to apply the 
modified name or click X to ignore any changes.

4. Toggle between the Rules (see Manage group rules) and Members tabs (see Manage 
members within a group) in the right panel.
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Manage group rules

1. In the Rules tab, click  to add a rule. 

To edit a rule, click the rule name.
2. In the expanded area, enter or edit the Name for the rule.
3. Define the rule criteria by selecting the Folder Type, Properties, an Operator, and Crite-

ria from the respective menus.

To add more criteria to the new rule, click  and repeat the selections of Folder Type/
Properties/Operator/Criteria. Multiple criteria within a rule for a group are applied 
using AND. For example, if a rule is specified that has 2 criteria, one stating that group 
permissions should be applied to folders of type “GRT Study” that have Indication = 
“GRT,” the other stating that group permissions should be applied to folders of type 
“GRT Study” that have Portfolio = “ABC,” the rule will apply permissions to folders of 
type “GRT Study” that have Indication = “”GRT” AND Portfolio = “ABC”.

Note: Description should not be used when defining rule criteria.
4. Check on/off the box(es) to define the permissions to grant the group when the rule cri-

teria are met. The permissions are grouped into 5 categories. Checking a box in the 
Check All category checks all boxes with the corresponding label in all of the other cate-
gories (e.g., if Read is checked under Check All, then Read will be checked for Root 
Folder, Data, Document, and Analysis). The remaining 4 categories represent the secu-
rity contexts that were assigned when the folder type was created: Root Folder, Data, 
Document, and Analysis. For each of these 4 categories, permissions can be set to allow 
a group to:
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Create content (add subfolders and upload files) 

Read the contents of the folder

Edit the contents of the folder

Delete the folder and its content

Lock the folder or files in the folder

View the folder contents even when blinded in a study

Set the folder or files to be blinded in the study

As an example, a rule is defined that, for all folders of the “Project” type, that have the 
“Therapeutic area” property “equal” to “Cardiovascular,” Read and Edit permissions of 
Documents will be granted to members of the group. This means that a user who is a 
member of the group for which this rule is defined, will be able to read and edit docu-
ments that are located in Cardiovascular-related projects. Refer to “Example of permis-
sion setup for an external partner” for another example.

5. Click Add to save the new rule or Apply to accept the modifications to the existing rule.

To delete a rule, click  to the far right of the rule.

Manage members within a group

1. With the desired group selected in the list on the left, select the Members tab on the 
right.

The list on the right shows all the users in the directory, but only the checked ones have 
access to the selected group.

2. To search for a member, type the name in the Search area above the list on the right.
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3. To sort the list of members, click a column header. Click the column header multiple 
times to switch between ascending, descending, and no sorting.

4. To add a user to the group, check the corresponding box. To remove a user from the 
group, uncheck the corresponding box.
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Delete a group in the system database

1. Click  in the toolbar and select the Groups tab.
2. Select the group name in the list on the left.

3. Click  next to the name and press OK in the confirmation popup.
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Example of permission setup for an external partner
For this example we will be setting up permissions for an external partner, named Tester 
Smith. Tester Smith will need the ability to create/read/edit data, create/read/edit docu-
ments, and read analyses for all projects to which the Clinical_BA group is given access.

Assign the role of Partner to the user
Assume that Tester Smith has been granted an account by Certara Support.

1. Click  to display the Users tab.
2. Locate and select Tester Smith in the left list.
3. With the Licenses tab selected on the right, check the box for the Partner license to 

assign it to Tester Smith.

Partner licensed users can create, read, edit, delete, view, and blind any folder, except the 
Root folder, which they cannot delete, view, or blind. However, Tester Smith must first be 
granted access to some folders before any of these permissions can take effect. Access can 
be granted by Group membership or specifically at the folder level, or by a combination of 
both.

Create a new group
Set up a Clinical_BA group. Later, we will assign Tester Smith as a member of this group.

1. Click  and select the Groups tab.

2. Click  at the top of the left list.
3. In the pop-up, enter Clinical_BA as the name of the new group and click Add.

We will add a rule for the Clinical_BA group that will define the criteria that must be met for 
certain permissions to be granted to its members. 

All information that the Clinical_BA group needs access to are in folders that are of the Proj-
ect type and have the Group property set to Clinical_BA. Therefore, a rule can be set up as 
follows:
4. Select Clinical_BA in the left list.
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5. With the Rules tab selected on the right, click . 
6. Type External partner as the name of the rule.
7. Set the Folder type to Project, Properties to Group, Operator to Equals, and Criteria to 

Clinical_BA.

8. Check the Read box under Check All. 
9. In the Data and Documents sections, check the Create and Edit boxes.

10. Click Add.

With this rule defined, members of the Clinical_BA group will be able to read all items and 
to create and edit data and document items within project folders that have the Group 
property set to Clinical_BA.

(Members could now be added to the new group, using the Members tab. However, this 
step will be skipped for this example.)

Add the user to the group
1. Select the Group Membership tab.
2. Check the Clinical_BA checkbox to add Tester Smith as a member.
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Tester Smith now has access to some folders as a member of the Clinical_BA group. Remem-
ber, as a Partner, a user can potentially create, read, edit, delete, view, and blind any folder, 
except the Root folder. However, the Clinical_BA group does not allow members to delete 
or blind a folder. 

Adjust folder permissions for the user
At this point, Tester Smith has access to any Project folder where the Group property is set 
to Clinical_BA. Let’s say that he is only involved with the PMX02 project. To allow access to 
only the information relevant to this project and no other project data, Tester Smith must 
first be removed from the Clinical_BA Group and then permissions need to be set for the 
PMX02 project folder. 

For this example, assume that a project folder called PMX02 exists in Integral.

1. Select the Group Membership tab and uncheck the Clinical_BA box.
2. Select the Folder Permissions tab.
3. Locate the PMX02 folder in the table. 

Use the Search Folder field to filter the table by typing PMX.
4. Check the Select All box for the PMX02 row.

Notice that  appears under some of the column headers to indicate that the permission 
required for the action is not currently granted to the user’s role. 

Note: The presence of the warning icon simply notifies you that the associated action will not be 
allowed for the user, even though the box is checked. There is no need to adjust the 
checkboxes in an attempt to get rid of the warning icon, as the action will be prevented 
regardless of the status of the checkbox. 
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Auditing Changes to Integral Data
Audit Reports are performed on files existing in the Data, Documents, or Analysis(es) fold-
ers only; folder changes are not included. However, a report can be initiated from the folder 
level, which will walk the folder/file tree and recursively create a report that includes all 
applicable files.

To generate an audit report for a folder

To generate an audit report for a savepoint

To generate an audit report for a file

Audit report contents

To generate an audit report for a folder

1. Go to the History tab of a folder.
2. Click the Generate Audit Report button.
3. In the popup, check the box for Include File Diffs if you want to include a comparison of 

the two most recent revisions of each file. 

Click Generate Report to generate the report as a .zip file.

Note: If you are using the Integral Plugin for Phoenix, the Save As dialog is displayed to allow 
you to change the filename and identify the directory in which to save the .zip file. Should 
you decide to change the name in the File Name field, it is important to include the .zip 
extension. 

See “Audit report contents” for more information.
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To generate an audit report for a savepoint

1. Go to the History tab of a savepoint-enabled folder.
2. Click the Generate Audit Report button.
3. In the popup, check the box for Include File Diffs if you want to include a comparison of 

the two most recent revisions of each file. 
4. Check the box for Include Savepoint Diffs and use the radio buttons to specify the save-

points to compare for differences. 

Most Recent VS Prior: If the file had 3 savepoints, this option compares savepoint 3 with 
2.

Most Recent VS First: This option compares savepoint 3 with 1.

Custom: Use the two pull-down menus to select the savepoints to compare.
5. Click Generate Report to generate the report and save it to your local directory as a .zip 

file.

See “Audit report contents” for more information.
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To generate an audit report for a file

1. Go to the History tab of a file.
2. Click the Generate Audit Report button.
3. In the popup, check the box for Include File Diffs if you want to include comparison of 

revisions in the report. 
4. If Include File Diffs is checked, use the radio buttons to specifying the revisions to com-

pare for differences. 

Most Recent VS Prior: If the file had 3 revisions, this option would compare revision 3 
with 2.

Most Recent VS First: This option would compare revision 3 with 1.

Custom: Use the two pull-down menus to select the revisions to compare.

Click Generate Report to generate the report and save it to your local directory as a .zip file.

See “Audit report contents” for more information.

Audit report contents
Compliance with 21 CFR Part 11 requires full accountability for all changes to study data, 
including inserting, deleting, and modifying data. Integral captures information for the fol-
lowing events. 

– adding a file
– adding a new revision of a file
– editing content of a file
– deleting a file or a folder containing files
– creating/updating links
– creating/updating copies
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– locking/unlocking
– blinding/unblinding 
– changing status of files or savepoint-enabled folders
– adding/updating/removing savepoint dependencies
– disabling eSignatures for a root folder (the entered reason for disabling is reported)

For each event, the following information is collected: 
– username
– date/time of modification (in UTC)
– event ID

The report itself is a .zip file that contains:

A main summary Report, in PDF format. The Integral instance and repository schema is fol-
lowed by a list of the files included in the report. There is also an indication if a Diff file is 
available. The report continues with a separate section for each file in the list. Each file’s 
section has three parts: 

– File summary: This section shows the name, path from the repository, author, cre-
ation date, revision number, size, and description of the file.

– Revision changes: For each revision of the file, the revision number, revision creation 
date, author, event ID, action, and reason for the revision are presented.

– Property changes: For each change to a property in the file, the revision number, 
name of the property, the value, the date/time of the change, and the author of the 
change, and the reason for the change are presented.

A file for each Diff (if requested). For text files, the Diff file is a PDF file showing a side by 
side comparison. For dataset files (CSV or XPT files), the Diff file is an Excel file listing the 
Column Name, Action, Previous Value, Current Value, User, and Event ID.

A file for savepoint Diff (if requested), in PDF format. A list of files added to the savepoint, 
files removed from the savepoint, and files with a new revision number.

Note: The audit report captures changes to files, but not folders. Therefore, not all event IDs will 
be found in an audit report. However, all actions are captured in the background and can 
be retrieved by submitting a support ticket. 
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System Audit Report
The system audit report captures activities/events that are not typically exposed in the inter-
face. The report contains audit information pertaining to security, administration, down-
loading, and other activities.

Security activities
– Add/remove user
– Add/modify/remove permission group
– Add/modify/remove rule from permission group
– Add/remove user from an assigned license or from a permission group
– Add/remove a user’s folder permissions and which permissions changed
– Disable eSignature for folder

Administration activities 
– Add/modify/remove folder type, property type, or file type
– Add/delete root folder
– Update the owner of a root folder

Downloading activities 
– Download any file, folder, or savepoint
– Download at folder level
– Download at file level
– Download deleted file
– Syncing root folder from Integral to local
– Syncing new files or folders added to a synced root folder from Integral to local

Other activities 
– Locking/Unlocking files or folders
– Blinding/Unblinding files or folders
– Deleting files or folders

Using this tool, customized system audit reports can be generated without needing to con-
tact Certara.

To access the system audit report, click  in the main toolbar.

Note: The System Audit Report icon is only visible if you have the “Administrator” or “QA” 
license.
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By default, the data is displayed using a Standard view. The Standard view is a stacked view, 
where every activity has the same structure and the details for a particular activity are con-
tained in a column called “Details.”

The Pivoted view separates the attributes listed in the Details column into individual col-
umns. If no filtering of activities is applied, the width of the table can grow by a substantial 
amount, as there are a large number of detail attributes possible for all of the tracked activ-
ities. If filtering is applied to only show a particular type of activity, the table is compressed 
to only display the columns of details that are relevant to that activity. Once in Pivoted 
view, it is then possible to filter based on individual detail attributes.

Sorting and filtering of columns in the system audit report is very similar to what is 
described in the “View and edit contents of a file” section with additional operators being 
available for filtering date/time columns. 

In the following Pivoted view image, the Activity column has been filtered to list only Securi-
tyGroupMember activities (the EventUser column is also filtered to list a particular user). 
There are only two details relevant to this activity: GroupName and UserID.
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Note: The filter icon in the column header will appear red if filter criteria has been applied to 
that column.

Use the navigation tools below the table to page through the data, go to a particular page, or 
to set the number of items to display per page.

To export the report, press the Export Excel or Export PDF button. Any data that has been 
filtered out will not be included in the report. 

Click  to force a refresh of the list.
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Integral Plugin
Integral is a database system for secure storage of study data and analyses. Integral pro-
vides a secure data management system with complete auditing capabilities. The combina-
tion of Integral and Phoenix provides an effective means to share source data, models, 
scripts, and results among the members of a drug development team. The combination also 
supports compliance with the U.S. Food and Drug Administration’s 21 CFR Part 11 regula-
tion.

Phoenix can work in conjunction with Integral for secure storage and change tracking for 
data and analyses. This section covers the use of Phoenix as an Integral client: loading Inte-
gral data to Phoenix and saving data from Phoenix as Integral projects and savepoints. Inte-
gral can also be accessed by way of a Web interface, which provides additional operations. 
See “Integral Introduction”.

This section contains the following topics:

Accessing the Integral browser

Adding a savepoint project

Defining the settings for a savepoint project

Confirming changes

Saving updated projects to Integral

Saving Phoenix Project as a Savepoint

Adding items to Integral

Loading Integral items in Phoenix

Detaching an item in Phoenix from Integral

Setting up a connection

Configuring default save options

Using PKS scenarios and Integral
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Accessing the Integral browser
Note: Connection to Integral from Phoenix requires the setting of some preference options. 

Refer to “Setting up a connection” for more information.

1. Select Integral > Browser from the main Phoenix menu to display the login page of Inte-
gral. 

2. Enter your credentials.

Once credentials are verified, the Integral interface is presented. 
3. If multiple Integral instances have been defined in the Preferences dialog, select the 

instance to use from the pull-down menu at the top of the browser dialog.

For details on using this interface, see the “Browser” section. 

Use the red X button to close the Integral browser dialog when finished.
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Adding a savepoint project
Note: Connection to Integral from Phoenix requires the setting of some preference options. 

Refer to “Setting up a connection” for more information.

Use Integral’s Add Savepoint option to create a new savepoint (Phoenix project). 

1. From Phoenix, open the Integral Browser (Integral > Browser).
2. Select the savepoint container folder (e.g., Analyses) in which to store the savepoint 

project.
3. Click the ellipsis for the selected folder and select Add Savepoint. 

4. In the Add Savepoint dialog, enter the title of the Phoenix project in the Savepoint name 
field.

5. Enter information in the Description field, if desired.
6. Check the box(es) for the folder(s) to include in the new savepoint. (Click a folder name 

to expand it and view the contents.)
7. Click Submit.

After the project is created in Phoenix, it will contain the data that was selected in the Add 
Savepoint dialog. You can proceed to work with the new project in Phoenix, for example, 
perform an NCA, add plots, or add some descriptive statistics. When finished with the work 
in Phoenix, select Integral > Save (or right-click the project in the Phoenix Object Browser 
and select Save to Integral). This will display the Settings dialog (see “Defining the settings 
for a savepoint project”) prior to creating a savepoint for the project in Integral.
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Defining the settings for a savepoint project
The settings for a savepoint project are divided into three separate tabs:

Savepoint tab

Save Options tab

Dependencies tab

Savepoint tab

In the Savepoint tab, define the savepoint using the available fields and menus. The options 
available are set up by the administrator.
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Save Options tab
1. Click the Save Options tab to choose the project items to save to Integral and the for-

mats.

In the Save Options Settings tab, each item available for export is listed. 
2. If a name other than the one assigned by Phoenix (shown in the Full Name field) is to be 

used when exporting an item, select the item and enter the new name, using the Latin 
alphabet, in the Name field.

Note: When results have a similar Path, it is important to provide unique names for the export. 
Otherwise, the save will fail with an error message. 

3. Select the format(s) in which to export the item by checking the box(es) in the Available 
Formats list.

4. Use the Clear Save Options button to remove any user-entered names or format set-
tings. Use the Apply Default Save Options button to use the default settings for the data 
type of the selected item. See “Configuring default save options” for details on setting 
up default save options.
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Dependencies tab
1. Click the Dependencies tab to set dependency tracking options.

Sub-folders and files in the selected savepoint container folder to which you have read 
access are listed in the Dependencies tab, along with their status.

2. Select the folders/files on which the savepoint project depends. (Note that selecting a 
folder selects all files within that folder.)

3. Checking the Invalidate Analysis On box for a dependency causes savepoints that refer-
ence the object to be marked as out-of-date (i.e., invalidated) when a different version 
of the object is saved to Integral. Clearing the checkbox will result in a savepoint not 
being marked out-of-date when a new version is saved to Integral.

4. Check the Notify box to send a message when the savepoint is invalidated. 

Objects loaded from Integral into Phoenix projects will have their dependencies main-
tained. 

After setting the savepoint properties, save options, and dependency customizations, press 
the right Arrow button to continue to the Confirmation page (see “Confirming changes”).
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Confirming changes

1. Check the Lock Savepoint and/or Blind Savepoint box(es) to lock/blind the savepoint 
immediately after it has been saved.

2. When ready to save, click Finish in the Confirmation dialog.
3. In the Electronic Signature popup, enter a statement regarding the new savepoint being 

added to Integral or select one from the Reason menu and click Next.
4. Enter your Integral credentials to complete the electronic signature.

The saving process begins, and a progress dialog is displayed. Once the Phoenix project has 
been saved to Integral, the progress dialog closes. 

Note: When a Phoenix project is loaded into Integral for the first time, a revision is logged. How-
ever, a savepoint (i.e., a snapshot of the project) will not be registered. Only after it is 
loaded into Phoenix from Integral and saved back will savepoints be registered. 
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Saving updated projects to Integral
The Integral Save and Save As options are enabled when an item or savepoint is loaded 
from Integral into the Object Browser. These options are in the Integral menu or on the 
right-click menu for a project in the Object Browser as Save to Integral and Save As to Inte-
gral. 

Using the Save option for a project creates a savepoint folder containing the Phoenix proj-
ect in Integral. A savepoint is a snapshot of the project as it currently exists. At any point in 
the future, you can take the project back to a prior state by loading the corresponding save-
point. 

Note: If the Phoenix project was generated using the Add Savepoint option in Integral (avail-
able on the savepoint container menu), no savepoint will be generated upon the initial 
save operation. The Add Savepoint option does not register the new Phoenix project in 
Integral, it simply creates the project in Phoenix. Therefore, the project file is not yet asso-
ciated with any savepoint container or Integral project. You must save the new project to 
Integral, then any subsequent saving operations will result in savepoints to which the 
project file is saved.

Once you load a project from Integral into Phoenix, create a savepoint before making any 
changes. You can then easily return to the starting point as needed. If you try to create a 
savepoint after making changes to the project, you are warned about the changes and 
asked to choose to either save the changes as a new savepoint (Save As) or discard the 
changes and load the latest saved version from Integral (Get Latest). 

Selecting either Save or Save As takes you to the Settings dialog, where you can make the 
necessary modifications before saving to Integral. See “Defining the settings for a savepoint 
project”.
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Saving Phoenix Project as a Savepoint
A Phoenix project file that was created outside of Integral and, therefore is not associated 
with a savepoint, can be saved to Integral as a savepoint. This allows savepoint features to 
be applied to the Phoenix project and changes can be saved as if it were a savepoint created 
through Integral.

1. In Phoenix, right-click the Phoenix project in the Object Browser. 

It must have the  icon before the name. If it has the  icon, it is already associated 
with Integral.

2. Select Save Project as Savepoint from the menu.

Once your Integral credentials have been verified, the Save Project as Savepoint dialog is 
displayed. 

3. All of the repositories to which you have been permitted access are listed in the Reposi-
tory pull-down. Select the one to which the Phoenix project is to be saved.

4. Identify the Integral savepoint container in which to save the Phoenix project as a save-
point by choosing the Root Folder first and then selecting the Savepoint Container. 

Use  to restrict the list of root folders to only the ones marked as favorites. To 

refresh the list, click .

Only savepoint containers to which you have appropriate permissions for saving are 
listed.

5. Click the arrow button at the bottom to proceed to the Settings page. 

Refer to the “Defining the settings for a savepoint project” and subsequent sections for 
further details. 

Once the process is completed, the electronic signature submitted (if required), and the 
Phoenix project saved to Integral, the icon in the Object Browser changes to .

Note: Users with an “Limited” license can only create eSignature disabled folders.
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Adding items to Integral
1. With the item to save selected in the Object Browser, select Integral > Add Selected 

Item (or right-click the item in the Object Browser and select Add Selected Item to Inte-
gral).

2. All of the repositories to which you have been permitted access are listed in the Reposi-
tory pull-down. Select the one to which the item is to be saved.

3. Enter a name (Name) for the item or use the default name.
4. Select the type of the item being added from the Type pull-down.

a. For SAS Transport Files, select the CDISC Model for the file from the menu. 
b. For Text (Space, Tab, or Comma delimited), check the box(es) if the file has a header 

row and/or has a units row.

Options available when a Phoenix object is selected are:

- Excel Workbook: Saves the object results worksheets to Integral.

- Phoenix Template: Saves the object as a .PHXTMPLT file.
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- Phoenix Object Settings: Saves the object settings to a .PHXSETTING file. 
5. Enter a description (Description) of the item.
6. Identify the Integral folder in which to save the item by choosing the Root Folder first 

and then selecting the sub-folder. 

Use  to restrict the list of root folders to only the ones marked as favorites. To 

refresh the list, click .

Items that do not appear in the Select Folder list include: savepoints, locked folders, 
blinded folders (unless you have View Blind, Create, and Read permissions for that 
folder), folders where upload=false, and folders where you do not have both Create and 
Read permissions

7. Optionally choose a Status for the item from the menu.

The values predefined in Integral include Final, Draft, Reviewed, and Approved. Other 
values may be defined by the Administrator. 

8. Press OK to add the item to Integral.

After entering the information for an electronic signature, if the item already exists in Inte-
gral, a pop-up dialog displays asking if the existing file should be overwritten. 

Press Yes to add the selected item as a new revision of the existing item. 

Press No to return to the Add Selected Item dialog without adding the item to Integral. 

When SAS Transport Files is selected as the Type, there is an additional step of reviewing 
the column names to complete the process. 

1. In the dialog, enter information that is appropriate for the data being exported:
– SAS Variable: The name of the SAS variable (limited to eight characters).
– SAS Label: The SAS column label header (limited to 40 characters).
– Include: Set to True to include or False to exclude the column.
– Precision Type: Set the precision type to either Significant Digits or Decimal Places.
– Precision: The number of significant digits or decimal places.
– Data Type: Select the data type as Numeric or Text, or leave it set to Auto to export 

the column as it is in Phoenix.
– Format: The .NET format to use for numeric data. G displays values in fixed-point or 

scientific notation (e.g., G, G4, G8). E displays values in scientific notation, followed 
by a precision specifier (e.g., E, E4, E8). F displays values in real numbers (e.g., F, F4, 
F8).

2. Optionally enter a Data Set Name.

This name is internal to SAS and independent of the actual file name.
3. From the Data Set Standard menu, choose the standard version (Version 5,6, Version 8, 

or Version 9).
4. To save the SAS export settings in the Documents folder, press Save Settings.

The settings are saved as a text file and named after the dataset name.
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5. To load the SAS export settings from the Documents folder, press Load Settings, select 
the SAS export settings file in the Documents folder, and press Select.

6. Press OK to save the worksheet as an SAS Transport File.



Loading Integral items in Phoenix

115

Loading Integral items in Phoenix
Note: Phoenix does not support line feeds. When loading data from Integral into Phoenix, make 

sure the data does not contain line feeds.

Open an Integral savepoint project in Phoenix
1. In Phoenix, open the Integral Browser (Integral > Browser).
2. In the Integral Browser, click the ellipsis button for a Phoenix project file, or a savepoint 

folder with its “Analysis Type” property set to “Phoenix Project” that contains a project 
file, and select Load Savepoint. 

(If the selected Phoenix project file is not in a “Phoenix Project” savepoint folder, use 
the Load Project option in the ellipsis menu.)

When a project is loaded from Integral, the right-click menu in Phoenix contains additional 
options. These include:

Check State: Checks to see if the version of the project loaded in Phoenix is identical to 
the one stored in Integral and displays a message stating the findings.

Refresh from Source: Reloads the project with the version stored in Integral.

You can also load a previous savepoint version from Integral to Phoenix through the Save-
point section of Integral’s History tab.

Open other items
From the Integral Browser (Integral > Browser), click ellipsis button for an item that Phoenix 
can read and select Load Selected Item.

If there are multiple projects open in Phoenix, a dialog will prompt for selecting the desired 
project. 

Items loaded into Phoenix using the Phoenix Integral Browser are read-only, unless they are 
detached. (See “Detaching an item in Phoenix from Integral”.) Also, if there are dependen-
cies that are out-of-date, a request is displayed asking if those dependencies should be 
updated.



Integral
Guide

116

Detaching an item in Phoenix from Integral
When an item from Integral is loaded into Phoenix, it is read only. You can break the con-
nection with Integral using the Detach option. When an item is detached from Integral, the 
source data information is cleared, and modifications can then be made without affecting 
the item stored in Integral. It also allows sharing the project with a user who does not have 
Integral installed.

From Phoenix, right-click the loaded Integral item and select Detach Integral Item.
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Setting up a connection
The Integral connection information must be provided before Phoenix can connect to Inte-
gral.

1. Select Edit > Preferences.
2. In the Preferences dialog, click the (+) sign beside Integral and select Instances.
3. Click Add to display the Integral Configuration dialog and enter the configuration prop-

erties.

To connect directly, enter the address to the web site in the Host Url field.

To connect via proxy, check the Use Proxy Server box and then choose whether to Use 
Default Proxy or Specify Proxy Settings by entering the Host and Port information to 
access a different proxy. (Check the Use Https box if this is an HTTPS proxy server.)

4. Click OK to save the new Integral instance.

To edit an existing Integral instance definition, select it in the Preferences dialog and click 
Edit. Then make the modifications in the displayed dialog.

To delete the instance definition, select it in the Preferences dialog and click Remove. 

Note: Users cannot edit or remove instances to which they are currently connected.
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Configuring default save options
The default save options can be configured in the Integral section in the Preferences dialog. 
The default save options determine how operational object output is displayed in Integral. 
An operational object’s output should be displayed when it is useful for data mining or 
reports, or if the output is loaded individually into another project to be re-used or shared.

1. Select Edit > Preferences.
2. In the Preferences dialog, select Integral > Default Save Options.
3. To add a default save option, click Add.

To edit an option, select it and click Edit.
4. In the Default Save Option dialog, select the Phoenix operational object from the Gener-

ated By pull-down menu.
5. From the Object Type pull-down menu, choose the type of object to be saved.
6. In the Object Name Pattern field, enter a pattern to look for in the name of the object 

to be saved.
7. From the Export Target Type pull-down menu, select the format for the exported file. 
8. Click OK to complete the save option definition.

For example, the previous image shows a new default save option being defined involv-
ing NCA. When the program encounters an NCA or a PK Model generated worksheet 
with a name that starts with “Final Parameter”, it is to be exported to Integral as an 
Excel workbook. Similarly, any Bioequivalence worksheet is to be saved as a text file 
(CSV), and any plot generated by the XY Plot object is to be saved to Integral as a JPEG 
file.
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9. To remove a save option, select the option and click Remove.
10. To save the defined options to an XML file, click Save to File, then select a location and 

enter a filename in the dialog. To load options from a file, click Load from File.

Saving the default save options to a file is a useful way of synchronizing settings across an 
organization.

Note that these are the “default” options and, as such, can be overridden in certain circum-
stances. For example, the use of a Phoenix template, in which save options have been spec-
ified, will override the default save options defined in the Phoenix Preferences dialog. The 
same is true for previously saved Analyses – the save options settings in the analysis take 
precedence over the default settings. 

You can clear the save settings from the template and apply Integral’s default save settings 
by using Clear Save Options button in the Save Options tab, followed by the Apply Default 
Save Options button. After doing this, the template can be saved to integral as a new revi-
sion and subsequent usages of the template will have updated save options.
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Using PKS scenarios and Integral
If you have the legacy PKS plugin, you can continue to use it to update data and scenarios. 
Any changes made through the PKS plugin will be synchronized with the information in Inte-
gral. However, the reverse situation is not true. Change made through Integral will not be 
synchronized to PKS. 

PKS scenarios can be opened in Phoenix through the Integral plugin by going to the corre-
sponding project and loading the desired scenario. Phoenix will open the scenario as a proj-
ect. Note that a new version of the scenario cannot be saved.
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Integral Client Application
The Integral Client Application is a synchronization tool between your local data and data 
uploaded to Certara Integral. Information on the following topics is available:

Connect Integral with Local Directory

User interface description

Set the local directory

Sync Integral root folder and contents to local directory

Sync new local folders and files to Integral

Sync Savepoints to Integral

Show dependencies

For more information on Integral itself, see “Learn About Integral”.
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Connect Integral with Local Directory
If the URL for Certara Integral was not specified during installation of the Client Application, 
you will need to do the following steps to access the application.

1. Double-click the Select File > Preferences from the menu.

2. In the Change Url pop-up, enter the URL for Certara Integral:

https://integral.certara.com/ 

and press Submit. 
3. In the Sign In pop-up, enter your Integral username and password and click Sign In.
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User interface description

Click  to view the Sync panels.

There are two panels, the left displays the Integral directory contents and the right shows 
the local directory content (once a local directory is specified (see “Set the local directory”). 
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Set the local directory
A local directory must be identified before any synchronization can occur. Do the following 
steps to set the local directory:

1. Click  to view the Sync panels.

2. Click  to display the Configuration popup. 

3. Specify the local folder to use as the Integral local directory by either typing directly in 
the Select Folder field or click Browse to use the file browser.

4. Click Save.
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Sync Integral root folder and contents to local directory
Only root folders are able to be synchronized from Integral to the local directory. If files and 
folders were modified within the root folder structure, the entire root folder will need to be 
synchronized from Integral to the local directory for the updates to show in the local direc-
tory.

1. Click .

2. In the Integral Directory list on the left, locate and select the root folder and click . 

Or

Click  and select Sync To Client.
3. In the Synchronize to Local popup, click Sync to confirm the action.

Note: If there is new content (file or subfolder) in both Integral and the local directory, and you 
want to keep the local new content, be sure to synchronize the local directory with Inte-
gral first. Otherwise the local new content will be replaced by the content from Integral.

4. Click OK once the synchronization is complete.
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Sync new local folders and files to Integral 
Synchronization from the local directory to Integral can happen at any level, root, folder, 
subfolder, file, etc. For savepoint enabled folders, the synchronization will happen at the 
savepoint folder level. It is best practice, when synchronizing a savepoint enabled folder, to 
synchronize at the savepoint folder level and not at a higher level (e.g., a parent or root 
folder). This allows access to options such as setting the type, choosing dependencies, etc.

Note: For root folders to synchronize, both the folder and structure must be created in Integral 
first. This is because Integral needs the folder type to be set before it synchronizes and 
this can only be done within Integral itself. Similarly, if the name of a root folder is 
changed locally, it must also be changed in Integral before synchronization will be suc-
cessful. 

When files are added to the local directory, they are listed in the Local Directory panel using 
a lighter blue color and gray title. When folders are added to the local directory, they are 
listed as either a solid yellow icon (indicates that the folder does not have an associated 
folder type) or a light blue icon (has an associated folder type but is not yet synchronized 
with Integral). The folder type must be assigned to a folder with a yellow icon before it can 
be synchronized with Integral.

Folders and files that have been synchronized with Integral display a darker blue color icon 
and the title is black.

To assign a folder type

1. Click  and select Set folder type.
2. Select the Folder Type from the pull-down.
3. Enter a Description in the field. 
4. Click Apply.

Once the type is set, the folder icon changes to the lighter blue color, indicating that it is 
now able to be synchronized with Integral.
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To synchronize to Integral

1. Select the new folder or file and click .

Or

Click  next to the new folder or file and select Sync to Integral from the menu.
2. Enter the electronic signature credentials required to perform the synchronization.

Note: If the folder is in a savepoint container folder (e.g., an Analyses folder), there are addi-
tional steps required for uploading. See “Sync Savepoints to Integral”

If any files are currently being used by another program (e.g., Excel), a warning message 
states that there are locked files preventing successful synchronization. (However, if a file, 
such as a .DAT or .TXT file, is simply open in a program like Notepad, the warning is not 
presented.)

Once the Integral update is complete, click  above the Local Directory panel to refresh 
the list. Notice that the icons change to the darker blue color and the titles are now black 
after synchronization.
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Sync Savepoints to Integral
Synchronization of a savepoint happens at the folder level. If a savepoint contains multiple 
files/project folders, after each synchronization, the version number will advance for the 
files/project folders with updated contents. Version numbers will remain unchanged for 
files/projects folders with no updates.

1. Select the savepoint folder and click .

Or

Click  next to the modified folder and select Sync to Integral from the menu.

The Synchronize to Integral wizard walks through the necessary steps required to set up 
the synchronization.

2. Enter the appropriate properties for the savepoint and click Next.
3. Check the boxes for any other savepoint enabled folders upon which the savepoint 

being uploaded depends and click Next.
4. Check the boxes for any local subfolders that should be excluded from the synchroniza-

tion with Integral and click Next. 

Selecting a folder will exclude all files/subfolders within it.
5. Enter the reason for the synchronization or select one from the menu and click Finish.
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6. Enter your electronic signature credentials and click Next to perform the synchroniza-
tion.

The synchronization begins and a new savepoint will be created (if the synchronization is 
successful). A popup will inform you when the synchronization has completed.
7. Click Close.

If the synchronization does not complete successfully, a popup message is displayed and the 
synchronization does not occur.
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Show dependencies

Click  next to the savepoint folder and select View Dependencies from the menu.

A Dependencies popup lists the name and revision number of the items on which the save-
point depends. It also lists the latest revision number available for that item, so you can 
quickly identify the items that need to be updated with the latest revisions. 
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Glossary
Actual time

Time that a dose or observation actually happened (in UTC), as opposed to nominal 
time. See also Relative time and Clock time.

Analysis

Any type of procedure that results in information that describes a set of data.

Analytical method

The type of assay that was performed to assess the concentration of drug (or other com-
pounds) in a sample, which is usually collected from blood, plasma, or urine.

Arm

Generally refers to a treatment or combination of treatments administered to a group 
of subjects or patients. For crossover studies, arm is sometimes used to denote a 
sequence group (a group of patients that received a particular sequence of treatments).

Assay

Analysis of a substance or mixture to determine the quantity of its constituents or to 
detect the presence of a substance.

Audit trail

A report that contains all additions, changes, and deletions made to the study data, 
units, observation data, and dosing data from Integral.

Baseline covariate

An independent variable in a Drug model, sampled before active treatment begins in a 
study.

Blinding type

Indicates which individuals involved in a study are allowed to see the treatments associ-
ated with data that is collected.

Clock time

Time expressed as a date and/or time (in UTC), rather than relative to first dose or start 
of study. See also Relative time.

Column

A display of the attributes of each subject and for each subject data collection point in a 
study. Columns can also contain observation data, reasons for changing data (for the 
audit trial), etc.
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Compound

The drug molecule under study. A compound may include one or more Formulation of 
that drug. The term is used in Integral to group studies that are investigating the same 
molecule.

Conversion factor

Part of an equation that enables conversion of data from one unit to another. For exam-
ple, to convert from grams to milligrams, multiply the number of grams by a conversion 
factor of 1,000 to get the number of milligrams.

Covariate

An independent variable in a Drug model. Generally, some subject characteristic of 
interest, such as age or blood pressure. See also Baseline covariate.

Database

A file or set of structurally-related files that contains data. May contain one or more 
data sets. For example, in Integral, users log on to one database, in which they may 
access any number of data sets.

Dropout

Event at which a subject’s participation in a study ends.

Drug model

Any combination of population PK/PD model(s), parameter and baseline covariate dis-
tributions, disease progress models, placebo models, adherence models, etc. A drug 
model may include one or more Structural model.

Duration

Length of an infusion dose.

End time

Time that a dose ends (for example, relative actual end time, relative nominal end 
time, etc.).

Event

Thing that happened at a specific time: a single dose, observation, or unscheduled 
event. See also Unscheduled event.

Form

Description of the physical attributes (i.e., an indication) associated with a product (i.e., 
a molecule).

Formulation

The point of dose input into a structural (PK/PD) model.

Formulation context

The dilution of the formulation.
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Grid

A grid control, displaying data in a worksheet. 

Group

Short for Treatment group.

Indication

An effect that is of interest produced by the application of a molecule. The FDA 
approves an indication, not a molecule. For example, the FDA approves Drug X for treat-
ing disease Y. The FDA does not approve Drug X in general.

Model

A set of mathematical equations that describe the underlying process of interest.

Model data

The information used to describe the process presented by the study data.

Nominal time

Time specified in the protocol for a dose or observation, as opposed to Actual time that a 
dose or observation was taken. Expressed relative to the first dose, or the start of the 
study, phase, or period.

Observation

A single piece of data for a subject collected at a particular data collection point. Obser-
vations can be explained, filtered, and analyzed by several defined dimensions. Each 
observation has associated audit information.

Observation data

Time-dependent events that contain some form of measured values. The data collected 
during the study.

Parameter

Variable defining the shape of a structural model.

Phase

A specific component of a clinical trial, such as lead-in or treatment.

Plot

A graph or chart of data.

Portfolio

A collection of molecules.

Product

Chemical entities (i.e., a molecule) under investigation in a study having an associated 
form.
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Profile

A collection of data points described by a collection of unique identifiers, which 
uniquely identify subject responses for a particular situation.

Property

Column properties are settings for a data column, i.e. column name, type and default 
units.

Protocol

Planned activities in the trial, including: enrollment, lead-in phase windowing, study 
design structure, subject assignments, and scheduled treatments and observations for 
the lead-in, active and follow-up phases of the study.

Relative time

Elapsed time since the first dose or the start of the study, period, or phase. As opposed 
to Clock time. Uses: relative nominal time or nominal_time_relative, relative actual 
time or actual_time_relative, relative actual end time or actual_end_time_relative. 
See also Nominal time and Actual time.

Savepoint

An analysis saved to Integral that requires an e-signature and represents a snapshot of 
the analysis and its results at that point in time. Savepoints are generated through the 
Integral Plugin for Phoenix or the Integral Client Application and are uniquely versioned 
by Integral automatically.

Sequence

Short for treatment sequence.

Simulation

Generally, a Monte-Carlo simulation.

Sort keys

A collection of unique database fields that distinguishes one set of data points from 
another (such as a plasma level profile). The difference between the sets of data points 
usually ascribes certain different attributes to the underlying processes being studied. 
For parallel trials, treatment and subject are generally the sort keys used to capture indi-
vidual subject data, while treatment, period (or phase), and subject are generally used 
for crossover trials.

Structural model

The set of functions defining the shape of a model (such as a structural PK, PD, or PK/PD 
model). Does not include parameter distributions.

Subject Identification

The ability to uniquely identify subjects is crucial to the functionality of the system. 
Since this application will be receiving data from many sources in many formats, no one 
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unique identifier exists between the systems. Integral requires users to define a set of 
fields (data elements) that, taken together, can uniquely identify a subject for a study.

Subject identifier

That which uniquely identifies a subject from any other subject in a study.

Treatment

Combination of one or more drugs given at specific doses and times/schedule.

Treatment group

Generic term for a treatment arm (in a parallel study design) or treatment sequence (in 
a crossover or Latin square study design).

Unit

The unit of measurement associated with sample data that are collected.

Unit category

A group of units that measure the same thing (length, time, concentration, etc.).

Unscheduled event

A PD event with some probability of occurrence, such as an adverse drug reaction or 
subject dropout.

Workbook

A file that contains one or more worksheets.

Worksheet

A page in a workbook that contains a data grid.
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